
 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Leddar IS16 
Industrial Solid-State LiDAR 

Sensor 
USER GUIDE 



 

 

 

 

 

 

                                                     

 

 

 

 

 

 

Page Intentionally Left Blank 

 



 

 

© 2019 LeddarTech® Inc. All rights reserved. 

LeddarTech® Inc., referred to as the Company shall not be liable for any errors contained herein or 

for any damages arising out of or related to this document or the information contained therein, 

even if the Company has been advised of the possibility of such damages. 

The information contained herein is the property of the Company, and shall not be reproduced in 

whole or in part without prior written approval of the Company. The Company assumes no 

responsibility for any errors or omissions in this document. 

Leddar is a trademark of LeddarTech® Inc. All other trademarks are the property of their respective 

owners. 

Leddar™ Configurator software: this software is based in part on the work of the Independent JPEG 

Group. 

  



 

 

DISCLAIMER 

LeddarTechTM Inc. reserves the right to modify the products and/or specifications described herein 

at any time, without notice, at LeddarTech’s sole discretion. Performance specifications and 

operating parameters of the described products are determined in an independent state and are 

not guaranteed to perform the same way when installed in customer products. The information 

contained herein is provided without representation or warranty of any kind, whether express or 

implied, including, but not limited to, the suitability of LeddarTech’s products for any particular 

purpose, an implied warranty of merchantability, or non-infringement of the intellectual property 

rights of others. This document is presented only as a guide and does not convey any license under 

intellectual property rights of LeddarTech or any third parties. 



 

Page 5 of 107 54A0023-14 042019 © LeddarTech Inc. 

Table of Contents 

 

List of Figures ................................................................................................................................ 8 

List of Tables ................................................................................................................................ 10 

 Introduction ...................................................................................................................... 12 

1.1. Description ................................................................................................................. 13 

1.2. Underlying Principles ................................................................................................. 15 

1.3. Beam Pattern ............................................................................................................. 16 

 Getting Started ................................................................................................................. 18 

2.1. Mechanical ................................................................................................................. 18 

2.2. Electrical ..................................................................................................................... 19 

2.2.1. Supply and Load Specifications ............................................................................ 19 

2.2.2. M12 Connector Pinout ........................................................................................... 19 

2.2.3. NPN Connection Diagram ..................................................................................... 21 

2.2.4. PNP Connection Diagram...................................................................................... 21 

 Control Panel ................................................................................................................... 22 

3.1. Description (with LCD Option) ................................................................................... 22 

3.2. Menus ........................................................................................................................ 24 

 Installing LeddarTM Configurator .................................................................................... 25 

 Presence Mode ................................................................................................................ 30 

5.1. Overview .................................................................................................................... 30 

5.2. Configuration Steps.................................................................................................... 30 

5.3. Teach Mode ............................................................................................................... 31 

5.3.1. Using the Teach Mode ........................................................................................... 31 

5.3.2. Optimal Installation ................................................................................................ 33 

5.4. Quick Mode ................................................................................................................ 33 

5.4.1. Description ............................................................................................................. 33 

5.4.2. Using the Quick Mode ........................................................................................... 34 

5.5. Advanced Mode ......................................................................................................... 35 

5.5.1. Description ............................................................................................................. 35 

5.5.2. Using the Advanced Mode .................................................................................... 36 

5.6. Outputs Configuration ................................................................................................ 37 

5.6.1. Type ....................................................................................................................... 37 

5.6.2. Activation Delay ..................................................................................................... 37 

5.6.3. Deactivation Delay ................................................................................................. 38 

5.7. Acquisition Settings .................................................................................................... 38 

5.7.1. General Settings .................................................................................................... 38 

5.7.2. Enabling and Disabling Segments ......................................................................... 40 



Leddar IS16 – User Guide  Page 6 of 107 

 Raw Measurements Mode ............................................................................................... 42 

6.1. Overview .................................................................................................................... 42 

6.2. Measurements Description ........................................................................................ 43 

6.3. Configuration .............................................................................................................. 44 

6.3.1. Acquisition settings ................................................................................................ 44 

6.3.2. Serial Port Settings ................................................................................................ 44 

6.3.3. CAN Port Settings .................................................................................................. 46 

6.4. Modbus Protocol ........................................................................................................ 48 

6.5. CAN Bus .................................................................................................................... 54 

6.6. SDK ............................................................................................................................ 62 

 Acquisition Settings ........................................................................................................ 64 

7.1. Measurement Rate..................................................................................................... 64 

7.2. Threshold Offset ......................................................................................................... 64 

7.3. Useful Range ............................................................................................................. 65 

7.4. LED Intensity .............................................................................................................. 65 

7.5. Object Demerging ...................................................................................................... 66 

7.6. Cross Talk Removal ................................................................................................... 67 

 LeddarTM Configurator..................................................................................................... 68 

8.1. Introduction ................................................................................................................ 68 

8.2. Connection Window ................................................................................................... 69 

8.2.1. Toolbar Display Controls ....................................................................................... 70 

8.2.2. Scale ...................................................................................................................... 71 

8.2.3. Panning and Zooming ............................................................................................ 71 

8.2.4. Changing the Sensor Origin .................................................................................. 73 

8.2.5. Changing the Sensor Orientation .......................................................................... 74 

8.3. Settings ...................................................................................................................... 75 

8.3.1. Device Name ......................................................................................................... 75 

8.3.2. Acquisition Settings ............................................................................................... 76 

8.3.3. Sensor Position ...................................................................................................... 77 

8.3.4. General .................................................................................................................. 78 

8.3.5. Serial Ports ............................................................................................................ 79 

8.3.6. CAN Ports .............................................................................................................. 81 

8.4. Saving and Loading a Configuration .......................................................................... 82 

8.5. Configuring Detection Records .................................................................................. 83 

8.6. Using Detection Records ........................................................................................... 85 

8.7. Data Logging .............................................................................................................. 87 

8.8. Device State ............................................................................................................... 89 

8.9. Preferences ................................................................................................................ 90 

8.10. Raw Detections .......................................................................................................... 91 

8.11. View Serial Port Data ................................................................................................. 94 

 Specifications .................................................................................................................. 96 

9.1. General ...................................................................................................................... 96 

9.2. Mechanical ................................................................................................................. 96 



 

Page 7 of 107 54A0023-14 042019 © LeddarTech Inc. 

9.3. Electrical ..................................................................................................................... 96 

9.4. Optical ........................................................................................................................ 97 

9.5. Performance ............................................................................................................... 99 

9.6. Dimensions .............................................................................................................. 101 

9.7. Regulatory Compliance ............................................................................................ 102 

 Technical Support ......................................................................................................... 103 

Index… ........................................................................................................................................ 104 

 

 

 



Leddar IS16 – User Guide  Page 8 of 107 

List of Figures 

 
Figure 1: IS16 Industrial LeddarTM Sensor .................................................................................... 14 

Figure 2: Illumination area and detection zone ............................................................................. 15 

Figure 3: Beam and distance measurement reference position .................................................... 16 

Figure 4: Mechanical dimensions .................................................................................................. 18 

Figure 5: NPN Connection diagram............................................................................................... 21 

Figure 6: PNP Connection diagram ............................................................................................... 21 

Figure 7: Control panel .................................................................................................................. 22 

Figure 8: Control panel menu ........................................................................................................ 24 

Figure 9: Welcome to the Leddar™ Software 3 Setup Wizard dialog box .................................... 25 

Figure 10: End-User License Agreement dialog box ..................................................................... 26 

Figure 11: Product Types dialog box ............................................................................................. 26 

Figure 12: Connecting to a sensor ................................................................................................ 27 

Figure 13: Connection dialog box .................................................................................................. 28 

Figure 14: Main window ................................................................................................................. 29 

Figure 15: Teach zone example .................................................................................................... 31 

Figure 16: Teach mode example ................................................................................................... 32 

Figure 17: Detection Zones dialog box (Teach mode) .................................................................. 33 

Figure 18: Quick mode examples (radial and perpendicular) ....................................................... 34 

Figure 19: Detection Zones dialog box (quick mode) .................................................................... 35 

Figure 20: Advanced mode zone example .................................................................................... 36 

Figure 21: Detection Zones dialog box (Advanced mode) ............................................................ 37 

Figure 22: General tab – Acquisition Settings dialog box (Advanced mode) ................................ 38 

Figure 23: Segments tab – Acquisition Settings dialog box (Advanced mode) ............................ 40 

Figure 24: Disabled segments example ........................................................................................ 41 

Figure 25: Raw Detections dialog box ........................................................................................... 42 

Figure 26: Detection thresholds ..................................................................................................... 64 

Figure 27: Raw Detections dialog box docked on the side of the main window ........................... 68 

Figure 28: Connection dialog box .................................................................................................. 69 

Figure 29: Leddar™ Configurator main window ............................................................................ 70 

Figure 30: Zooming in (left) and out (right) horizontally................................................................. 72 

Figure 31: Zooming in (left) and out (right) vertically ..................................................................... 72 

Figure 32: Detection point coordinates .......................................................................................... 73 

Figure 33: Dot indicator to modify the sensor origin ...................................................................... 73 

Figure 34: Sensor position display ................................................................................................ 74 

Figure 35: Red bar to rotate the sensor position ........................................................................... 75 

Figure 36: Device menu and The Configuration menu items ........................................................ 76 

Figure 37: Device Name dialog box .............................................................................................. 76 

Figure 38: Acquisition Settings dialog box .................................................................................... 77 

Figure 39: Device menu and Sensor Position dialog box ............................................................. 77 

Figure 40: Device menu, and the Configuration and Communication menu items ....................... 78 

Figure 41: General Settings dialog box ......................................................................................... 78 

Figure 42: LeddarHost dialog box ................................................................................................. 79 

Figure 43: Device menu, and the Configuration and Communication menu items ....................... 79 

Figure 44: Serial Ports Settings dialog box ................................................................................... 80 

Figure 45: Device menu, and the Configuration and Communication menu items ....................... 81 



 

Page 9 of 107 54A0023-14 042019 © LeddarTech Inc. 

Figure 46: CAN Port Settings dialog box ....................................................................................... 81 

Figure 47: File menu ...................................................................................................................... 83 

Figure 48: Settings menu .............................................................................................................. 83 

Figure 49: Preferences dialog box................................................................................................. 84 

Figure 50: File menu ...................................................................................................................... 84 

Figure 51: File menu to stop a recording ....................................................................................... 85 

Figure 52: File menu to open a recording ..................................................................................... 86 

Figure 53: Record Replay dialog box ............................................................................................ 86 

Figure 54: Settings menu .............................................................................................................. 87 

Figure 55: Preferences dialog box for logging data....................................................................... 88 

Figure 56: File menu ...................................................................................................................... 88 

Figure 57: File menu to stop data recording .................................................................................. 88 

Figure 58: View menu .................................................................................................................... 89 

Figure 59: Device State window .................................................................................................... 89 

Figure 60: Settings Menu and Preferences Dialog Box ................................................................ 90 

Figure 61: View menu and Raw Detections dialog box ................................................................. 92 

Figure 62: Example of detection filters .......................................................................................... 92 

Figure 63: View menu .................................................................................................................... 94 

Figure 64: Serial Port Viewer dialog box ....................................................................................... 95 

Figure 65: Serial port measurement .............................................................................................. 95 

Figure 66: Detection efficiency (beam width by segments) ........................................................... 98 

Figure 67: Detection efficiency (beam height) ............................................................................... 98 

Figure 68: Accuracy vs. amplitude ................................................................................................ 99 

Figure 69: Precision vs. amplitude ................................................................................................ 99 

Figure 70: Amplitude vs. distance ............................................................................................... 100 

Figure 71: Casing dimensions ..................................................................................................... 101 

 

 

  



Leddar IS16 – User Guide  Page 10 of 107 

List of Tables 
 

Table 1: Beam cross-section dimensions vs. distance.................................................................. 17 

Table 2: Supply and load specifications ........................................................................................ 19 

Table 3: Connector pinout ............................................................................................................. 19 

Table 4: IS16 connection cable and pinout description ................................................................. 20 

Table 5: M12 Cable Color Code .................................................................................................... 20 

Table 6: Control panel indicator functions ..................................................................................... 22 

Table 7: Control panel pushbutton functions ................................................................................. 23 

Table 8: Acquisition setting description ......................................................................................... 39 

Table 9: Raw detection field description ........................................................................................ 43 

Table 10: Flag value description.................................................................................................... 43 

Table 11: Status value description ................................................................................................ 44 

Table 12: Serial port settings description ...................................................................................... 45 

Table 13: Maximum detections per Baud  rate/Measurement rate settings .................................. 45 

Table 14: CAN port settings .......................................................................................................... 46 

Table 15: Report server ID message............................................................................................. 48 

Table 16: Get detection message (detection fields) ...................................................................... 49 

Table 17: Get detection message (trailing fields) .......................................................................... 49 

Table 18: Get detection message (detection fields) ...................................................................... 50 

Table 19: Get detection message (trailing fields) .......................................................................... 50 

Table 20: Read input register message ........................................................................................ 50 

Table 21: Read holding, write register, and write multiple register definition ................................ 52 

Table 22: CAN bus request message............................................................................................ 54 

Table 23: CAN bus request message (GET input data) ................................................................ 55 

Table 24: CAN bus request message (GET holding data) ............................................................ 56 

Table 25: CAN bus request message (SET holding data) ............................................................ 56 

Table 26: CAN bus answer message ............................................................................................ 59 

Table 27: CAN bus number of detection message ........................................................................ 59 

Table 28: CAN bus answer message (GET input data) ................................................................ 60 

Table 29: Standard CAN bus detection message ......................................................................... 61 

Table 30: Flag information of measurement .................................................................................. 62 

Table 31: CAN bus detection message definition with flag information ........................................ 62 

Table 32: Serial port settings description ...................................................................................... 80 

Table 33: CAN port setting description .......................................................................................... 82 

Table 34: Field description of the log text file ................................................................................ 87 

Table 35: Flag value description.................................................................................................... 94 

Table 36: Status value description ................................................................................................ 94 

Table 37: General specifications ................................................................................................... 96 

Table 38: Mechanical specifications .............................................................................................. 96 

Table 39: Electrical specifications ................................................................................................. 96 

Table 40: Optical specifications ..................................................................................................... 97 

Table 41: Sensor performances .................................................................................................... 99 

Table 42: Compliance to standards ............................................................................................. 102 

 

 



 

Page 11 of 107 54A0023-14 042019 © LeddarTech Inc. 

 

 

 

 

 

 

 

 

 

 

 

Page Intentionally Left Blank



Leddar IS16 – User Guide Page 12 of 107 

 Introduction 

At the heart of the IS16 industrial LeddarTM sensor lies a patented Leddar™ Technology, designed 

to detect, locate and measure all types of objects that are either solid or liquid. The IS16 industrial 

LeddarTM sensor provides both distance and angular positioning while performing continuous 

analysis of the area. Specifically designed for the industrial market, this unique sensor is optimized 

for 0 to 50 meter detection and ranging applications. 

Based on time-of-flight measurements using pulses from infrared LEDs, combined with 16 

independent active segments, the IS16 industrial LeddarTM sensor provides fast, accurate and non-

stop detection and ranging. The 45-degree beam, produced by diffused light pulses and processed 

through innovative algorithms, allows for the detection of a wide range of objects under various 

environmental conditions. And with its LCD option, configuring and monitoring ongoing operations 

is a snap. 

Presence detection mode (full configuration only) 

This sensor integrates a Presence Detection Mode where the PNP/NPN outputs indicate the 

presence of objects within the configured zones (two zones, one per output).  

Using Teach mode configuration, the sensor uses the perimeter of its surroundings as a detection 

zone. 

In Quick mode, a near limit and a far limit are set to quickly define zones.  

In Advanced mode, near and far limits can be set for each segment and unwanted segments can 

be deactivated. 

WARNING! The IS16 industrial LeddarTM sensor does NOT include self-checking redundant 

circuitry required for use in personal safety applications. A sensor failure or malfunction can result 

in OPEN or CLOSED state on the PNP/NPN outputs. Never use this product as a sensing device 

for personal safety. Their use as safety devices may create an unsafe condition which could lead 

to injury or death. 

Raw measurements mode 

The IS16 industrial LeddarTM sensor provides the capabilities to acquire all measurements, from all 

segments— in real time— through the RS-485 link or the CAN bus. Each measurement provides 

the distance of the detected object, the index of the segment it was detected in, and the intensity 

of the measurement (indication of how much light was reflected off the object and captured by the 

sensor). 
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1.1. Description 

The IS16 industrial LeddarTM sensor is offered in many configurations. 

The full configuration option includes all features of the presence detection mode and the raw 

measurement mode. 

The raw measurement configuration option provides only the distance of the detected object, the 

index of the segment it was detected in, and the intensity of the measurement. No digital output 

and LCD are provided for this option. 

The LCD option is offered only for the full configuration option. The presence of the LCD in the 

control panel provides advanced configuration setting directly on the sensor.  When the LCD is not 

present, the advanced configuration settings are done using the LeddarTM Configurator software. 

Each configuration if offered with the RS-485 or the CAN bus interface. 

The IS16 industrial LeddarTM sensor package contains everything needed to get started: 

• Sensor 

• Quick reference guide 
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Figure 1: IS16 Industrial LeddarTM Sensor 

The sensor1 offers the following features: 

• 0 to 50 meters (165 ft) detection 

• Rapid measurement rate – up to 50 Hz 

• Beam width 45°, height 7.5° 

• 16 detection segments (width 2.8°, height 7.5°) 

• 2 NPN/PNP outputs (1 per detection zone) 

• Control panel for on-site configuration 

• LCD option for on-site monitoring 

• IP67 weather-resistant enclosure 

• RS-485 or CAN bus for configuration and measurement acquisition 

• USB port for configuration and measurement acquisition 

• Software for configuration and monitoring (USB) 

• SDK and code examples (RS-485, USB, Windows, Linux) 
 

NOTE: Lens coating color for 45° configuration may change from one sample to another from 
greenish to bluish, but the inherent properties of the lens are not affected in the field of 
application of this product. 

 

                                           

 

1 The sensor model described in this document is a 45° sensor. Please contact LeddarTech for other 

available beam options. 

Control panel 

USB port 

8-pin M12 

connector 

Reception optics 

Emission optics 
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1.2. Underlying Principles 

Created by LeddarTech, LEDDAR™ (light-emitting diode detection and ranging) is a unique 

sensing technology based on LED illumination (in either the visible or the infrared spectrum) and 

the time-of-flight of light principle. The LED emitters illuminate the area of interest (pulsed typically 

at 100 kHz) and the multichannel sensor receiver collects the backscatter of the emitted light and 

measures the time taken for the emitted light to return to the sensor. A 16-channel photodetector 

array is used and provides multiple detection and ranging segments. Full-waveform analysis 

enables detection and distance measurement of multiple objects in each segment, provided that 

foreground objects do not fully dark objects behind them. Oversampling and accumulation 

techniques are used to provide extended resolution and range. 

Figure 2 illustrates the illumination area and detection segments of the evaluation kit. The 16 

channels provide a profile of the object in the beam. In other installations, the 16 channels can be 

used to locate and track one or multiple objects in the beam. 

  

 

Figure 2: Illumination area and detection zone 

The core of Leddar™ sensing is the pulsing of diffused light, collection of reflected light, and full-

waveform analysis (including oversampling and accumulation). The light source type, the number 

of light sources, and the illumination and reception beam, can all be tailored to fit specific application 

requirements such as detection range, beam, and spatial resolution. 
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1.3. Beam Pattern 

 

Figure 3: Beam and distance measurement reference position 

The LEDs and emission optics create a diffused light beam to illuminate the scene while the 

reception lens collects the backscatter of light from objects in the beam onto a multi-element photo 

detector.  

The lens specifications and photo detector geometry result in a beam with 48° width (w) and 8° 

height (h). Note that the detection sensitivity varies within the beam and limits that are not clear cut 

at 48° and 8°. Figure 66 and Figure 67 illustrate how the sensitivity varies within the cross-section 

of the beam (width and height). For example, Figure 67 indicates that the sensitivity drops to less 

than half of the maximum outside of an optimal 6° range. 

Figure 3: Beam and distance measurement reference position 

Figure 3 illustrates various cross-sections of the beam (at 5 m, 10 m and 50 m) and how the beam 

is segmented (16 segments). The following equations can be used to approximate the beam cross-

section dimensions at a given distance (d) from the sensor. 

Beam width = d x 0.8905 

Beam height = d x 0.1402 

Each segment has a width 1/16th of the beam width and the same height as the beam. The following 

table provides beam cross-section dimensions for various distances from the sensor. 
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Table 1: Beam cross-section dimensions vs. distance 

Distance Beam Width Beam Height Segment Width 
Segment 
Height 

0.5 0.45 0.07 0.03 0.07 

1 0.89 0.14 0.06 0.14 

2 1.78 0.28 0.11 0.28 

5 4.45 0.70 0.28 0.70 

10 8.91 1.40 0.56 1.40 

15 13.36 2.10 0.83 2.10 

20 17.81 2.80 1.11 2.80 

25 22.26 3.51 1.39 3.51 

30 26.72 4.21 1.67 4.21 

35 31.17 4.91 1.95 4.91 

40 35.62 5.61 2.23 5.61 

45 40.07 6.31 2.50 6.31 

50 44.53 7.01 2.78 7.01 
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 Getting Started 

This chapter presents the mechanical and electrical installation information. 

2.1. Mechanical  

SHCS M4, M5, 8-32 or 10-24 screws are recommended for installing the IS16 industrial LeddarTM 

sensor. 

  

 

Figure 4: Mechanical dimensions 

   

NOTE: The connector illustrated above is a male connector even though threads are not represented. 

  



 

Page 19 of 107 54A0023-14 042019 © LeddarTech Inc. 

 

2.2. Electrical 

2.2.1. Supply and Load Specifications 

Table 2: Supply and load specifications 

DC supply voltage 12-30 V 

PNP/NPN output load current (max) 100 mA 

 

2.2.2. Connector Pinout 

Table 3: Connector pinout 

Pinout Pin # Full Configuration 
Raw Measurement 

Configuration 

 

1 RS-485- / CAN_L RS-485- / CAN_L 

2 DC SUPPLY DC SUPPLY 

3 
ANALOG OUT  

(4-20mA, 0-10V)* 

No connect 

4 
PNP/NPN OUT1 

(ZONE 1) 

No connect 

5 
PNP/NPN OUT2 

(ZONE 2) 

No connect 

6 RS-485+ / CAN_H RS-485+ / CAN_H 

7 GND GND 

8 INPUT* No connect 

* Provision for future use 
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2.2.3. Connection Cable  

Below is the information about the cable required to connect to your IS16 (the cable must be 

ordered separately). 

Table 4: IS16 connection cable and pinout description 

M12 Connection Cable  
and Pinout 

Description 

 

M12 Circular Connector, 8 pos Female socket with #24 
wires, 2 m , IP65-IP67-IP68, 2 A, 30 V, wire-ended 

Consult this page to know the specifications about this 
cable. 

 

Connection diagram. Please note that it is inverted 
compared to the IS16 connector pinout (Table 3).  

 

Table 5: M12 Cable Color Code 

M12 COLOUR CODE 

1 WHITE RS-485- / CAN_L 

2 BROWN DC_SUPPLY 

3 GREEN ANALOG OUT 

4 YELLOW OUT1 

5 GRAY OUT2 

6 PINK RS-485+ / CAN_H 

7 BLUE GND 

8 RED INPUT* 
 

https://www.phoenixcontact.com/online/portal/ca?uri=pxc-oc-itemdetail:pid=1406105&library=caen&pcck=P&tab=1#Dimensions
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2.2.4. NPN Connection Diagram 

 

Figure 5: NPN Connection diagram 

 

2.2.5. PNP Connection Diagram 

 

Figure 6: PNP Connection diagram 
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 Control Panel 

This section explains the functionality of the control panel with an LCD. For the control panel without 

the LCD, the buttons and the output LED are inactive and reserved for future use. The Power LED 

keeps the same functionality and the Signal LED informs the presence of an object in its detection 

range. 

3.1. Description (with LCD Option) 

The control panel provides several buttons and indicators and a display used to navigate through 

the menu for the sensor configuration. 

 

Figure 7: Control panel 

 

Table 6: Control panel indicator functions 

Indicator Function 

Power On when the sensor has power 

Signal 

• During normal operations, it is on when no objects are detected. 

• During the teach operation, it is on if an object is not detected in all segments 
(used to warn the far limit will be set to the limit of the beam). 

Out 1 On when zone 1 is activated (object detected in the zone). 

Out 2 On when zone 2 is activated (object detected in the zone). 
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Table 7: Control panel pushbutton functions 

Key Function 

 

Backspace 
• Move back to the menu or move to the previous digit.  

• Hold 2 seconds to exit changes. 

  

Arrows 

• Move up/down in the menu.  

• Modify settings and digits. 

 

Enter 

• Move forward in the menu or next digit.  

• Apply changes. 
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3.2. Menus 

 

      

Figure 8: Control panel menu 

 

  

Display 

Measurement 

Rate 

Zone 2 

Information 

State (Enable/Disable) 

Configuration 

Output Setup 

Zone 1 

Press any 

key to 

access the 

menu 

Settings 

Teach 

Quick Setup 

Type (NPN/PNP) 
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Deactivation 

Delay 

Contrast 

Backlight 

Part Number 

Serial Number 

Firmware Ver. 
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Press  at green menu items 

to display or modify info/settings 
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 Installing LeddarTM Configurator 

This chapter presents the steps to install Leddar™ Configurator and start using the IS16. 

To install Leddar™ Configurator: 

In the computer CD/DVD drive, insert the software CD. 

The installation software starts automatically. 

OR 

Download the LeddarInstaller.exe file from our Web site at http://support.leddartech.com/login. 

If you are a new user, fill out the form and click Submit. 

If you are a registered user, login by entering your e-mail address and password, and click Log In. 

In the Download section, click a product and then click LeddarInstaller.exe. Double-click the file to 

start the installation. 

NOTE: For Microsoft Windows® XP, an upgrade of Microsoft components and a restart may be 

required. Follow the instructions and do not remove the installation CD from the CD/DVD 

drive. Installation will automatically resume after restarting the computer. 

1. On the computer desktop, double-click the Leddar™ Configurator icon. 

2. In the Welcome to the Leddar™ Software 3 Setup Wizard dialog box, click Next. 

 

Figure 9: Welcome to the Leddar™ Software 3 Setup Wizard dialog box 

3. In the End-User License Agreement dialog box, read the terms of the agreement, select the 

I accept the terms in the License Agreement check box, and click Next. 

http://support.leddartech.com/login
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Figure 10: End-User License Agreement dialog box 

 

4. In the Product Types dialog box, the Leddar™ Software Development Kit check box is 
selected by default. 

NOTE: If you do not want to install the development kit, clear the check box. 

 

Figure 11: Product Types dialog box 

5. Click Next. 

6. In the Destination Folder dialog box, click Next to select the default destination folder. 

OR 

Click the Change button to choose a destination folder. 
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7. In the Ready to Install Leddar™ Software 3 dialog box, click the Install button. 

8. In the Completed the Leddar™ Software 3 Setup Wizard dialog box, click Finish. 

Leddar™ Configurator creates an icon on the computer desktop. 

Connecting to the Sensor 

The first time the sensor is connected to a computer, a few seconds are required for Windows™ to 

detect it and complete the installation. 

NOTE: For Windows™ XP, you may be prompted for installation instructions upon detection of 

the sensor. Accept the default or recommended settings. 

Once the installation is completed, you can connect to the sensor. 

To connect to the sensor: 

1. Connect the power cord to the sensor and to a power outlet. 

2. Connect the USB cable to the sensor and to the computer. 

3. On the computer desktop, double-click the Leddar™ Configurator icon. 

4. In the Configurator main window, click the connect button . 

 

Figure 12: Connecting to a sensor 

5. In the Connection dialog box, in the Select a connection type list, select the 
IS16/M16/Evaluation Kit USB connection. 
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Figure 13: Connection dialog box 

6. In the product list, select the product and click the Connect button. 
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The main window displays the detections (green lines) in the segments (white lines). 

 

Figure 14: Main window 

A complete description of Leddar™ Configurator features and parameters is presented in 

Chapter 8. 
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 Presence Mode 

NOTE: This chapter applies for the full configuration only 

5.1. Overview 

In presence mode, user-defined zones in the sensor beam are used to activate the NPN/PNP 

outputs when an object is present within a zone. 

Two zones can be configured, one for each output. 

Each output can be separately enabled and configured as NPN or PNP. The outputs can also be 

configured to be “CLOSED” (source/sink current) on object presence or “OPEN” on object 

presence.  

NOTE: On power loss, the outputs will be in OPEN state, regardless of the output configuration. 

WARNING! The IS16 industrial LeddarTM sensor does NOT include self-checking redundant 

circuitry required for use in personal safety applications. A sensor failure or malfunction can result 

in OPEN or CLOSED state on the PNP/NPN outputs. Never use this product as a sensing device 

for personal safety. Their use as safety devices may create an unsafe condition which could lead 

to injury or death. 

A zone is defined by near and far limits for each segment in the sensor beam (16 segments) and 

can be configured in different ways. 

5.2. Configuration Steps 

To use the sensor in presence detection mode, at least the following steps are required: 

1. Configure the zones (using Teach, Quick, or Advanced) 
2. Configure and enable the outputs. 

Optimal performance may require adjustment of other parameters such as the measurement rate 

and output activation and deactivation delays. Note that other advanced parameters (detection 

threshold offset, useful range, LED power, object demerging) are only adjustable with Leddar™ 

Configurator. 
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5.3. Teach Mode 

With the Teach mode, the sensor sets the near limit of each segment to 0 and sets the far limit of 

each segment to the closest object detected in each segment minus the gap setting. 

Figure 15 shows an example zone obtained through teaching configuration. The gap in each 

segment is visible between the green line (the detected object position) and the orange line (far 

limit). 

 

Figure 15: Teach zone example 

 

5.3.1. Using the Teach Mode 

Control panel (with LCD option) 

Enter the Teach items (see      

Figure 8). The gap setting will be requested (in meters). Use the enter/back buttons to move 

across digits and the up/down buttons to modify the digit values. 

Make sure nothing is blocking the sensor and that nothing is moving within the desired zone. 
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Press the enter button on the last digit to start the Teach configuration. 

A countdown appears (to clear the sensor) then the Teach configuration starts. The SIGNAL LED 

will light if the Teach fails (see section 5.3.2). The result will also be indicated on the display. In the 

Teach mode, the sensor sets the near limit of each segment to 0 and sets the far limit of each 

segment to the closest object detected in each segment minus the gap setting. Figure 15 shows 

an example of a zone obtained using the Teach configuration. The gap in each segment is visible 

between the green line (the detected object position) and the orange line (far limit). 

LeddarTM Configurator software 

The software provides a Detection Zones dialog box for zone configuration. 

To open it, click the Device menu, point to Configuration, and click Detection Zones. 

 

Figure 16: Teach mode example 

To configure the zone in Teach mode, select the desired zone, select the Teach configuration 

mode, adjust the gap setting, and click the Teach button. 
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Figure 17: Detection Zones dialog box (Teach mode) 

5.3.2. Optimal Installation 

The Teach mode will operate most effectively if the following conditions are met: 

• Every segment has a detected object as part of the sensor perimeter. If not, the far limit of 
empty segments will be set to the beam limit. The Quick or Advanced mode should be 
considered for these installations. 

• The zone is delimited with a static perimeter (for example, wall, floor). Dynamic changes to 
the perimeter may result in false zone activation. 

 

 

5.4. Quick Mode 

5.4.1. Description 

In Quick mode, a zone is created with all segments configured with the same near and far limits. 

Two near and far limit distance types are available, radial and perpendicular. Figure 18 illustrates 

2 examples of zones created with the Quick mode for each distance type. 
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Figure 18: Quick mode examples (radial and perpendicular) 

 

5.4.2. Using the Quick Mode 

Control panel (with LCD option) 

Enter the Quick mode menu item (see Figure 6). The near and far settings will be requested (in 

meters). Use the enter/back buttons to move across digits and the up/down buttons to modify the 

digit values. Press the enter button on the last digit to move forward in the setup steps. 

The mode will be requested as well. Choose radial or perpendicular and press enter to complete 

the quick mode configuration. 

LeddarTM Configurator software 

The software Detection Zones dialog box provides a button to select the Quick mode 

configuration. 

To open it, on the Device menu, point to Configuration and click Detection Zones. 

To configure the zone in Quick mode, select the desired zone, select Quick, adjust the near and 

far limits, and click the Apply button (green check mark). Note that the near and far limits are 

adjustable graphically in the main window by clicking the limit line and dragging it closer or farther 

from the sensor. 
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Figure 19: Detection Zones dialog box (quick mode) 

 

5.5. Advanced Mode 

5.5.1. Description 

In Advanced mode, the near and far limit of each segment is configurable and unwanted segments 

can be disabled. This mode provides the highest flexibility to create custom zones. 
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Figure 20: Advanced mode zone example 

 

5.5.2. Using the Advanced Mode 

The Advanced mode is only available using LeddarTM Configurator. The software provides a 

Detection Zones dialog box for zone configuration. 

To open it, on the Device menu, point to Configuration, and click Detection Zones. 

To configure the zone in Advance mode, select the desired zone, select Advanced, clear the check 

boxes of unwanted segments and set the near and far limits for each active segment. Note that 

each segment near and far limits are adjustable graphically in the main window by clicking the limit 

line and dragging it closer to or farther from the sensor. 
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Figure 21: Detection Zones dialog box (Advanced mode) 

5.6. Outputs Configuration 

The outputs can be configured through the control panel (see Figure 6) or the LeddarTM 

Configurator software (in the zone configuration window). 

5.6.1. Type 

The sensor outputs may be configured to one of these settings: 

• NPN, normally OPEN (open when no presence in the zone) 

• NPN, normally CLOSED (closed when no presence in the zone) 

• PNP, normally OPEN 

• PNP, normally CLOSED 

NOTE: On power loss, the outputs will be in the OPEN state, regardless of the output type 

configuration. 

5.6.2. Activation Delay 

The activation delay is used to set a minimum number of consecutive measurements with an object 

in the zone before switching the output to the “presence” state. 
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NOTE: Since the parameter is a number of measurements, the delay will vary if the measurement 

rate is changed. 

5.6.3. Deactivation Delay 

The deactivation delay is used to set a minimum number of consecutive measurements without an 

object in the zone before switching the output to the inactive zone state.  

NOTE: Since the parameter is a number of measurements, the delay will vary if the measurement 

rate is changed. 

5.7. Acquisition Settings 

The following settings may be adjusted to optimize the operation of the sensor in presence mode. 

These settings are found in the Acquisition Settings dialog box. To open the Acquisition 

Settings dialog box, select Device > Configuration > Acquisition. 

5.7.1. General Settings 

 

Figure 22: General tab – Acquisition Settings dialog box (Advanced mode) 

To apply new acquisition settings, click the apply button  in the main window. 
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Table 8: Acquisition setting description 

Setting Effect More Information 

Measurement 

Rate 

Decreasing improves precision and range. 

Increasing improves zone activation response time 

Section 7.1 

Threshold 

Offset 

Increasing reduces sensitivity and range.  

This can help filter out secondary objects in the 

scene.  

Section 7.2  

Useful Range 
Decreasing reduces the maximum distance the 

sensor will detect objects. 

Section 7.3 

LED Control 

Provides manual or automatic control of the LED 

intensity (automatic by default). 

 

Selects between manual and automatic power 

control. In automatic, the LED power is adjusted 

according to incoming detection amplitudes.  

 

The current LED power level is visible in the View 

> State > Device State window.  

Section 7.4 

Change Delay 

Minimum frame delay between power changes. 

Smaller numbers speed up the response time of the 

laser power adjustment. 

N/A 

Object 

demerging 

Improves discrimination of 2 close objects in the 

same segment. 

Available at measurement rates 1.5625, 3.125 and 

6.25 Hz. 

Section 7.5 

Crosstalk 

Removal  

Inter-channel interference noise removal Section 7.6 
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5.7.2. Enabling and Disabling Segments 

To open the Acquisition Settings dialog box, select Device > Configuration > Acquisition. 

Segments are enabled by default. 

 

Figure 23: Segments tab – Acquisition Settings dialog box (Advanced mode) 

 

When you uncheck a pair of segments, the corresponding segments will appear with gray square 

lines in the main window as shown in the image below. 
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Figure 24: Disabled segments example 

To apply new acquisition settings, click the apply button  in the main window. 
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 Raw Measurements Mode 

This chapter applies only for both the advanced detection and the raw measurement configurations. 

6.1. Overview 

The raw measurements mode refers to use of the sensor with acquisition of the object detection 

and distance measurement data. The data available in raw measurement can be displayed in the 

LeddarTM Configurator from the View menu by clicking the Raw Detections command. Data can 

be collected through the serial link [RS­485 link (Modbus protocol)/CAN bus] or USB link (SDK). 

 

Figure 25: Raw Detections dialog box 
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6.2. Measurements Description 

An object crossing the beam of the sensor is detected and measured. It is qualified by its distance, 

segment position, and amplitude. The quantity of light reflected and captured by the sensor 

determines the amplitude. 

   Table 9: Raw detection field description 

Field Description 

Segment (Seg) Beam segment in which the object is detected 

Distance Position of the detected object 

Amplitude Quantity of light reflected by the object and measured by the sensor 

Flags 8-bit status (bit field). See Table 10. 

 

The Flags parameter provides the status information that indicates the measurement type. Table 

10 presents the flag definitions for data transferred through the USB link. See section 6.4 for the 

description of flags available through the RS-485 link. 

Table 10: Flag value description 

Bit position Bit = 0 Bit = 1 

0 Invalid measurement Valid measurement 

1 
Normal measurement Measurement is the result of demerging processing 

(see section 7.5). 

2 Reserved Reserved 

3 

Normal measurement Received signal is above the saturation level. 

Measurements are valid (VALID is set) but have a 

lower accuracy and precision. 

Consider decreasing the LED intensity. 

4 Reserved Reserved 

5 Reserved Reserved 

6 Reserved Reserved 
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Bit position Bit = 0 Bit = 1 

7 Reserved Reserved 

 

The Flags field provisions for 8 bits encoded as a bit field. Three bits are currently used. The 

following table presents the example decimal values of the status bit field. 

Table 11: Status value description 

Status value 

(decimal) 
Status value (binary) Description 

1 00000001 Normal measurement (valid) 

9 00001001 Saturated signal (valid) 

 

6.3. Configuration 

6.3.1. Acquisition settings 

The acquisition settings can be adjusted to optimize the sensor for high measurement rate, 

precision or range. These settings are described in detail in section 7. 

6.3.2. Serial Port Settings 

A number of serial port settings are available to adjust data acquisition through the RS-485 link. 

Typical serial port settings such as baud rates and start/stop bits can be configured to the desired 

values. 

A baud rate of 115200 is recommended to provide the best data transfer rate and measurement 

rate up to 50 Hz. The following serial port settings are configurable. 
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Table 12: Serial port settings description 

Parameter Value 

Port Number Select 1 for the RS-485 port on the terminal block. 

Baud rate 

9 600 bps 

19,200 bps 

38,400 bps 

57,600 bps 

115,200 bps 

230,400 bps1 

460,800 bps1 

921,600 bps1 

Parity None, odd, even 

Stop bits 1, 2 

Address 1 to 247 

Detections2 0 to 48 

 

1 To avoid errors, it is recommended not to select these rates. Availability according to selected serial port. 
2 This parameter can be limited to 40 if used with a 0x6A Modbus function. 
 

The Detections parameter is the maximum number of detections to output in Modbus data 

transfers (Get detections – function code 0x41). This can be used to match the data transfer rate 

to the sensor measurement rate (the sensor will drop measurements if the measurement rate 

exceeds the data transfer rate). 

In order to give an equal chance to each segment, the sensor parses all segments to output their 

nearest measurement and then pass to the second nearest, etc. until either there are no more 

detections to output, or the configured number of detections is reached. 

The following table lists the theoretical maximum number of detections that can be transferred to 

different baud rates and measurement rates. This assumes the host can sustain the resulting data 

transfer rate. 

Table 13: Maximum detections per Baud  
rate/Measurement rate settings 

Baud\Hz 1.5625 3.125 6.25 12.5 25 50 

921,600 bps* 48 48 48 48 48 48 

460,800 bps* 48 48 48 48 48 48 

230,400 bps* 48 48 48 48 48 48 

115,200 bps 48 48 48 48 48 32 

57,600 bps 48 48 48 32 32 14 
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Baud\Hz 1.5625 3.125 6.25 12.5 25 50 

38,400 bps 48 48 48 44 20 8 

19,200 bps 48 48 44 20 8 2 

9 600 bps 48 44 20 8 2 2 

* To avoid errors, it is recommended not to select these rates. Availability according to selected serial port. 

6.3.3. CAN Port Settings 

The CAN port settings are available to adjust data acquisition through the CAN link. Typical CAN 

port settings such as baud rate, Tx and Rx ID, frame format, inter-message and inter-cycle delay, 

flag information, maximum number of detection to output, and the message mode can be 

configured. 

The following CAN port settings are available. 

Table 14: CAN port settings 

Parameter Value 

Baud Rate 10, 20, 50, 100, 125, 250, 500, 1000 kbps 

Base Tx ID 

The CAN arbitration ID used for data messages. From the sensor containing 

the detections. The arbitration ID of the messages containing the number of 

detections will be this value plus one (see the protocol documentation). 

Base Rx ID 
The CAN arbitration ID used for data messages to the evaluation kit (see the 

protocol documentation). 

Frame Format Standard, Extended 

Inter-Message 

Delay 

0 to 65535 milliseconds 

Inter-Cycle 

Delay 

0 to 65535 milliseconds 

Flag Information Enable, Disable (standard detection message) 

Detection 1 to 96 

Message Mode Single or multiple 
 

 

The CAN port supports two frame format standards: the standard 11 identifier bits and the extended 

29 identifier bits. 

For a CAN host device that uses limited resources, it is possible to slow down the CAN data 

transmission by adding configurable delays from 0 to 65535 milliseconds: 

The Inter-Message Delay parameter is a delay to add between two CAN messages. 

The Inter-Cycle Delay parameter is a delay to add between two acquisition cycles message block. 

It is especially used to send detection in continuous mode. 
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The Flag Information parameter, when activated, gives an 8-bit field additional information of 

measurement. 

The Detections parameters is the maximum number of detections to output in the CAN bus. This 

can be used to limit the range of message ID used in multiple­message mode. In order to give an 

equal chance to each segment, the sensor parses all segments to output their nearest 

measurement and then move to the next nearest, and so on until either there are no more 

detections to output or the configured number of detections is reached. 

The Message Mode parameter is the type of transmission data on the CAN link. Two message 

modes are available. Please refer to section 6.5 for more information. 
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6.4. Modbus Protocol 

The RS-485 port on the sensor uses the Modbus protocol using the RTU transmission mode only. 

This section describes the commands that are implemented. 

For more information on the Modbus protocol, please visit www.modbus.org. 

Report server ID (function code 0x11) 

This function returns information on the sensor in the following format: 

Table 15: Report server ID message 

Offset Length Description 

0 1 
Number of bytes of information (excluding this one). Currently 0x95 

since the size of information returned is fixed. 

1 32 Serial number as an ASCII string 

33 1 
Run status 0: OFF, 0xFF:ON. Should always return 0xFF, otherwise the 

sensor is defective. 

34 64 The device name as a Unicode string 

98 16 The software part number as an ASCII string 

114 16 The hardware part number as an ASCII string 

130 8 The full firmware version as 4 16-bit values 

138 4 The firmware 32-bit CRC 

142 2 The firmware type (LeddarTech internal use) 

144 2 The FPGA version 

146 4 Device option flags (LeddarTech internal use) 

150 2 Device identification code (8 for IS16) 

 

Get detections (function code 0x41) 

This function returns the detections/measurements in the following format: 

The first byte is the number of detections in the message. Because of the limitation on a Modbus 

message length, a maximum of 48 detections will be returned. This is not a problem as it is very 

unlikely to have more than 48 detections in a real-world application. Note that this maximum can 

be configured to a lower value using Leddar™ Configurator (serial port configuration) or the Write 

Register command described below. 

  

http://www.modbus.org/
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Following the first byte, each detection entry has five bytes: 

Table 16: Get detection message (detection fields) 

Offset Length Description 

0 2 
The distance in centimeters (little-endian). Distance unit is defined 

by holding register 14. 

2 2 The amplitude times 64 (i.e., amplitude = this field/64) (little-endian) 

4 1 

Low 4 bits are flags describing the measurement: 

Bit 0 - Detection is valid (will always be set) 

Bit 1 - Detection was the result of object demerging 

Bit 2 - Reserved 

Bit 3 - Detection is saturated 

High 4 bits are the segment number. 

 

Three more data fields follow the detection list: 

Table 17: Get detection message (trailing fields) 

Offset Length Description 

0 4 
Timestamp of the acquisition (little-endian). The timestamp is expressed as 

the number of milliseconds since the sensor was started. 

4 1 Current LED power as a percentage of maximum. 

5 1 

Current acquisition statuses. This is an 8-bit:  

Bit 0 – Reserved 

Bit 1 - Object demerging is completed if 1 when this function is activated. 

Bit 2 – Test mode detections (0 = standard detection, 1 = detection from 

test mode). This field is valid only if failsafe product option is available. 

 

Get detections and flags info (function code 0x6A) 

This function returns the detections/measurements in the following format: 

The first byte is the number of detections in the message. Because of the limitation on a Modbus 

message length, a maximum of 40 detections will be returned. 

NOTE:  This maximum can be configured to a lower value using the Leddar™ Configurator 

software (serial port configuration) or the Write Register command described below. 

This configuration parameter is same as original “Get detection” (0x41) function but if it 

is over than 40 detections, it will be internally overrides to a maximum of 40 detections 

for this “Get detection and flags info” (0x6A) function. 

Following the first byte, each detection has six bytes: 
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Table 18: Get detection message (detection fields) 

Offset Length Description 

0 2 
The distance in centimeters (little-endian). Distance unit is defined by 
holding register 14. 

2 2 The amplitude times 64 (that is, amplitude = this field/64)(little-endian) 

4 1 

4 bits are flags describing the measurement (all others are reserved): 

Bit 0 - Detection is valid (will always be set) 

Bit 1 - Detection is the result of object demerging 

Bit 3 - Detection is saturated 

Bit 6 - Detection is within the crosstalk zone 

5 1 Segment number 

 

Three more data fields follow the detection list: 

Table 19: Get detection message (trailing fields) 

Offset Length Description 

0 4 
Timestamp of the acquisition (little-endian). The timestamp is 
expressed as the number of milliseconds since the device was started. 

4 1 Current laser power as a percentage of maximum. 

5 1 

Current acquisition statuses. This is an 8-bit:  

Bit 0 – Reserved 

Bit 1 - Object demerging is completed if 1 when this function is 
activated. 

Bit 2 – Test mode detections (0 = standard detection, 1 = detection from 
test mode). This field is valid only if failsafe product option is available. 

 

Read input register (function code 0x4) 

Here are the registers implemented for this command: 

Table 20: Read input register message 

Address Description 

0 
Sensor temperature in degree Celsius. Fixed point value with an 8­bit fractional 

part (that is, temperature is the register value divided by 256). 

1 

Detection status for polling mode: 

0 = Detections not ready. 

1 = Detections ready: this register is reset to 0 on reading input registers from 

addresses 13 to 207 or on execution of “get detections” function (code 0x6A). 
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Address Description 

13 

Least significant byte is the current LED power as a percentage of maximum. Most 

significant byte is acquisition statuses: bit 0 indicates that automatic LED intensity 

is enabled if 1, bit 2 indicates that object demerging is enabled if 1. 

14 Low 16 bits of timestamp (number of milliseconds since the sensor was started) 

15 High 16 bits of timestamp 

16-31 
Distance in centimeters of first detection for each segment, zero if no detection in 

a segment. Distance unit is defined by holding register 14. 

32-47 
Amplitude of first detection for each segment times 64 (i.e., amplitude = this 

register/64), zero if no detection in a segment 

48-63 Distance of second detection for each segment 

64-79 Amplitude of second detection for each segment 

80-95 Distance of third detection 

96-111 Amplitude of third detection 

112-127 Distance of fourth detection 

128-143 Amplitude of fourth detection 

144-159 Distance of fifth detection 

160-175 Amplitude of fifth detection 

176-191 Distance of sixth detection 

192-207 Amplitude of sixth detection 

208 

Least significant byte is the current laser power as a percentage of the maximum. 

Most significant byte is acquisition statuses: bit 0 indicates that the automatic laser 

intensity is enabled if 1, bit 2 indicates that object demerging is enabled if 1. This 

register content is same as input register 13 

209 
Low 16 bits of timestamp (number of milliseconds since the sensor was started). 

This register content is same as input register 14. 

210 High 16 bits of timestamp. This register content is same as input register 15. 

211-226 
Distance in centimeters of first detection for each segment, zero if no detection in 

a segment. Distance unit is defined by holding register 14 

227-242 
Amplitude of first detection for each segment times 64 (that is, amplitude = this 

register/64), zero if no detection in a segment 

243-258 Flags of first detection for each segment, refer to Table 10 and Table 30. 

259-274 Distance of second detection for each segment 

275-290 Amplitude of second detection for each segment 

291-306 Flags of second detection for each segment 

307-322 Distance of third detection 

323-338 Amplitude of third detection 
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Address Description 

339-354 Flags of third detection 

355-370 Distance of fourth detection 

371-386 Amplitude of fourth detection 

387-402 Flags of fourth detection 

403-418 Distance of fifth detection 

419-434 Amplitude of fifth detection 

435-450 Flags of fifth detection 

451-466 Distance of sixth detection 

467-482 Amplitude of sixth detection 

483-498 Flags of sixth detection 

Note that as per the Modbus protocol, register values are returned in big­endian format. 

Read holding register (function code 0x3), write register (function code 0x6) and write 

multiple registers (function code 0x10) 

Here are the registers implemented for these commands (see section 7 for a more detailed 

description of parameters). 

Table 21: Read holding, write register, and write multiple register definition 

Address Description 

0 to 2 Reserved 

3 

Measurement rate in Hz.  

The value of this register is n in the following: 

8 = 50 Hz 

9 = 25 Hz 

10 = 12.5 Hz 

11 = 6.25 Hz 

12 = 3.125 Hz 

13 = 1.5625 Hz 

4 

Detection threshold as a fixed-point value with an 8-bit fractional part (i.e. threshold 

value is this register divided by 256). The range is limited to a maximum of 100.0 

and to a variable minimum determined by the accumulation and oversampling 

settings (read back the register to know the actual value set). 

5 

LED power in percentage of the maximum. A value above 100 is an error. Only 

the LED intensity values defined in section 7.4 should be used. If a value is 

specified that is not one of the predefined values, the closest predefined value will 

be used. The register can be read back to know the actual value set. Note that this 

value is ignored if Automatic LED intensity is enabled. 

6 Bit field of acquisition options with 3 bits currently defined (all others are reserved): 
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Address Description 

Bit 0 – Automatic LED intensity enabled 

Bit 2 – Object demerging enabled 

Bit 3 – Crosstalk removal disabled (disabled if 1) 

Bit 8 – Automatic LED intensity mode: 

0 = Mode 1 

1 = Mode 2 

7 Change delay in number of measurements 

8 

Maximum number of detections (measurements) returned by function 0x41 and 

0x6A*. 

* Can be limited to 40 if used with a 0x6A Modbus function. 

9 and 10 Reserved 

11 Reserved 

12 and 13 Reserved 

14 

Distance units: 

mm = 1000 

cm = 100 

dm = 10 

m = 1 

15 Communication segment activation: Bits field of selected channels to activate 

16 
Bit field for test mode (if failsafe product option is available): 

Bit 0 – Test mode activation (0 = OFF, 1 = ON), volatile setting to default OFF state 

17 Reserved 

18 Acquisition segment pair activation: bits field of selected segment pair to activate. 

19 to 26 Reserved 

27 Port configuration stop bits: Set to 1 or 2. 

28 

Port configuration parity: 

0 = none 

1 = odd 

2 = even 

29 

Port configuration Baud rate: 

0 = 9 600 bps 

1 = 19,200 bps 

2 = 38,400 bps 

3 = 57,600 bps 

4 = 115,200 bps 

5 = 230,400 bps* 

6 = 460,800 bps* 
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Address Description 

7 = 921,600 bps* 

30 Port configuration Modbus sensor address: Set from 1 to 247. 
 

* To avoid errors, it is recommended not to select these rates. Availability according to selected serial port. 

 

To set up the port configuration, it is recommended to do the “read holding registers” and “write 

multiple register” commands for the entire range of Modbus holding register address from 27 to 30 

inclusively. 

The “write register” and “write multiple register” command execution will fail if this sensor is USB 

connected to a host device: the error code 4 will be returned. 

Note that as per the Modbus protocol, register values are returned in big­endian format. 

A request for a register that does not exist will return error code 2. Trying to set a register to an 

invalid value will return error code 3. If an error occurs while trying to execute the function, error 

code 4 will be returned. 

6.5. CAN Bus 

The CAN port in single message mode uses the 1872 (0x750) base ID to send all detection 

message. When sending detection, one 0x751 message will be sent followed by as many 1872 

(0x750) base ID messages as needed. 

The CAN port in multiple message mode uses a maximum range from 1874 (0x752) ID to 1922 

(0x782) of a standard message or a maximum range from 1874 (0x752) ID to 1970 (0x7B2) of 

messages with detection flag information. When sending detection, one 0x751 message will be 

sent followed by messages on ID range from 1874 (0x752) to as needed in multiple message mode. 

Four different message ids are available (these IDs can be modified with the Leddar™ Configurator 

software). 

1856 (0x740) (Rx base ID) 

This is an 8-byte message length for command request that the sensor listens for: the first byte 

(Byte 0) describe the main function and rest of message bytes are used as arguments. The 

undescribed bytes are reserved and must be set to 0. 

Table 22: CAN bus request message 

Function 
Request 
(Byte 0) 

Function Request Description 
Function Arguments 

(Byte 1) 

1 Legacy: Send detections once 
- 

2 Legacy: Start sending detections 

continuously (the sensor will 

- 
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Function 
Request 
(Byte 0) 

Function Request Description 
Function Arguments 

(Byte 1) 

send a new set of detections 

each time they are ready without 

waiting for a request). 

3 
Stop sending detections 

continuously 

- 

4 

Send detection once Bit field of operation mode (this override 

CAN Operation Mode field in CAN port 

configuration 3): 

Bit-0: 0 = return detection in single 

message mode, 1 = return detection in 

multiple message mode  

Bit-1: reserved 

Bit-2: reserved 

Bit-3: detection flag message activation 

5 

Start sending detections 

continuously (i.e., the sensor will 

send a new set of detections 

each time they are ready without 

waiting for a request). 

Bit field of operation mode (this override 

CAN Operation Mode field in CAN port 

configuration 3): 

Bit-0: 0 = return detection in single 

message mode, 1 = return detection in 

multiple message mode  

Bit-1: reserved 

Bit-2: reserved 

Bit-3: detection flag message activation 

6 GET input data (read only) See Table 23 

7 GET holding data See Table 24 

8 SET holding data See Table 25 
 

NOTE:  The GET and SET function messages always return an answer message on the 1873 

(0x751) base ID, see section below. 

Table 23: CAN bus request message (GET input data) 

Input Data Type 
(Byte 1) 

Input Data Description 

0 Temperature 

1 Device identification and option 

2 Firmware version 

3 FPGA version 
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Input Data Type 
(Byte 1) 

Input Data Description 

4 to 9 Serial number 

10 to 20 Device name 

21 to 23 Software part number 

24 to 26 Hardware part number 
 

Table 24: CAN bus request message (GET holding data) 

Holding Data Type 
(Byte 1) 

Holding Data Description 

0 Reserved 

1 Measurement rate 

2 Detection threshold 

3 LED power percent (%) 

4 Acquisition option 

5 Auto acquisition average frames 

6 Reserved 

7 Distance resolution 

8 Communication segment enable 

9 CAN port configuration 1 

10 CAN port configuration 2 

11 CAN port configuration 3 

12 Test mode 

13 Reserved 

14 Acquisition segment pair enable 
 

 

Table 25: CAN bus request message (SET holding data) 

Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Arguments Arguments Description 

0 Reserved - - 

1 

Measurement 

rate 

Byte 2 Measurement rate in Hz. Value of this field is 

expressed by n in this following formula 

12800/2n and must be: 

8 = 50 Hz 

9 = 25 Hz 

10 = 12.5 Hz 
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Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Arguments Arguments Description 

11 = 6.25 Hz 

12 = 3.125 Hz 

13 = 1.5625 Hz 

2 

Detection 

threshold 

Byte 4 Detection threshold as a fixed-point value with a 

19-bit fractional part (that is, threshold value is 

this register divided by 524288). The range is 

limited to a maximum of 100.0 and to a variable 

minimum determined by the accumulation and 

oversampling settings (read back the register to 

know the actual value set). 

Byte 5 

Byte 6 

Byte 7 

3 

LED power 

percent (%) 

Byte 2 LED power in percentage of the maximum. A 

value above 100 is an error. Only the LED 

intensity values defined in section 7.2 should be 

used. If a value is specified that is not one of the 

predefined values, the closest predefined value 

will be used. The register can be read back to 

know the actual value set. Note that this value 

is ignored if Automatic LED intensity is enabled.  

4 

Acquisition 

option 

Byte 2 Bit field of acquisition options with 3 bits 

currently defined (all others are reserved):  

Bit 0 – Automatic LED intensity enabled 

Bit 2 – Object demerging enabled  

Bit 3 – Crosstalk removal disable (disable if 1) 

Bit 8 – Automatic LED intensity mode: 

0 = Mode 1 

1 = Mode 2 

Byte 3 

5 

Auto 

acquisition 

average 

frames 

Byte 2 Change delay in number of measurements 

Byte 3 

6 Reserved Byte 2 Reserved 

7 

Distance units Byte 2 Distance units:  

mm = 1000 

cm = 100 

dm = 10 

m = 1 

Byte 3 

8 Byte 2 
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Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Arguments Arguments Description 

Communicatio

n segment 

enable 

Byte 3 Bits field of activated segment for 

communication 

9 

CAN port 

configuration 

1 

Byte 2 Baud rate: 

0 = 1000 kbps 

1 = 500 kbps 

2 = 250 kbps 

3 = 125 kbps 

4 = 100 kbps 

5 = 50 kbps 

6 = 20 kbps 

7 = 10 kbps 

Byte 3 Frame format: 

0 = standard 11 bits 

1 = extended 29 bits 

Byte 4 Tx base ID 

Byte 5 

Byte 6 

Byte 7 

10 

CAN port 

configuration 

2 

Byte 4 Rx base ID 

Byte 5 

Byte 6 

Byte 7 

11 

CAN port 

configuration 

3 

Byte 2 CAN Operation Mode bits field: 

Bit-0: 0 = return detection in single message 

mode, 1 = return detection in multiple message 

mode 

Bit-1: inter-message delay activation 

Bit-2: inter-cycle delay activation 

Bit-3: detection flag message activation 

Byte 3 Maximum number of detections 

(measurements) returned per CAN detection 

message transaction: 1 to 96 

Byte 4 Inter-message delay 0 to 65535 milliseconds 

Byte 5 

Byte 6 Inter-cycle delay 0 to 65535 milliseconds 

Byte 7 
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Holding 
Data Type 

(Byte 1) 

Holding Data 
Description 

Arguments Arguments Description 

12 

Test mode Byte 2 Bit field for test mode (if failsafe product option 

is available): 

Bit 0 – Test mode activation (0 = OFF, 1 = ON), 

volatile setting to default OFF state 

Byte 3 

13 
Reserved - - 

14 

Acquisition 

segment pair 

enable 

Byte 2 Bits field of segment pair enable for acquisition 

Byte 3 

 

NOTE:  The SET command execution will fail if this sensor is USB connected to a host device: 

an error answer message will be returned. 

1873 (0x751) (Tx base ID + 1) 

This is an 8-byte message that indicates: the number of detections that will be sent or the answer 

to the GET and SET command requests. 

Table 26: CAN bus answer message 

Answer Data 
(Byte 0) 

Answer Data Description 
Additional Answer Data 

(Byte 1 to Byte 7) 

Equal or less 

than 96 
Number of detections See Table 22 

128 + 6 
Answer to GET input data 

request 

Success: See format in Table 23 

Fail: All byte 2 to byte 7 are set to 0xFF 

128 + 7 
Answer to GET holding data 

request 

Success: See format in Table 25 

Fail: All byte 2 to byte 7 are set to 0xFF 

128 + 8 

Answer to SET holding data 

request 

Success: Return echo of the SET command 

request. 

Fail: All byte 2 to byte 7 are set to 0xFF 
 

 

Table 27: CAN bus number of detection message 

Data Data Return Description 

Byte 0 Number of detections 

Byte 1 Reserved 

Byte 2 Current LED power as a percentage of maximum 

Byte 3 Current acquisition statuses. This is an 8-bit field:  
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Data Data Return Description 

Bit 0 – Reserved 

Bit 1 – Object demerging is completed if set to 1 when this function is activated. 

Bit 2 – Test mode detections (0 = standard detection, 1 = detection from test mode). 

This field is valid only if failsafe product option is available. 

Byte 4 Timestamp of the acquisition. The timestamp is expressed as the number of 

milliseconds since the sensor was started. Byte 5 

Byte 6 

Byte 7 
 

 

Table 28: CAN bus answer message (GET input data) 

Input Data 
Type 

(Byte 1) 

Input Data 
Description 

Arguments Arguments Description 

0 

Temperature Byte 4 Temperature as a fixed-point value with 

a 16-bits fractional part (that is, 

temperature value is this register divided 

by 65536). 

Byte 5 

Byte 6 

Byte 7 

1 

Device identification 

and options 

Byte 2 Device identification code (8 for IS16) 

Byte 3 

Byte 4 Device option flags (LeddarTech internal 

use) Byte 5 

Byte 6 

Byte 7 

2 

Firmware version Byte 2 The firmware build version 

Byte 3 

Byte 4 The firmware 32-bit CRC 

Byte 5 

Byte 6 

Byte 7 

3 

FPGA version Byte 2 The FPGA version 

Byte 3 

Byte 4 The firmware type (LeddarTech internal 

use) Byte 5 

Byte 6 Run status 0: OFF, 0xFF:ON. Should 

always return 0xFF, otherwise the sensor 

is defective. 
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Input Data 
Type 

(Byte 1) 

Input Data 
Description 

Arguments Arguments Description 

4 to 9 
Serial number Byte 2 to Byte 7 Serial number as an ASCII string (max 32 

bytes) 

10 to 20 
Device name Byte 2 to Byte 7 The device name as a Unicode string 

(max 64 bytes) 

21 to 23 
Software part 

number 

Byte 2 to Byte 7 The software part number as an ASCII 

string (max 16 bytes) 

24 to 26 
Hardware part 

number 

Byte 2 to Byte 7 The hardware part number as an ASCII 

string (max 16 bytes) 

1872 (0x750) (Tx base ID) 

This is an 8-byte message containing detection(s) use in single message mode. Two (2) types of 

message are supported: standard detection message and detection message with flag information. 

The standard detection message containing two (2) detections: if the number of detections is odd, 

the last message will be 0 filled in the last 4 bytes. The message is separated in two parts with the 

same format: 

Data bytes 0 and 1 contain the distance in units defined by “distance units” holding data. 

Data byte 2 and the 4 LSBs of byte 3 contain the amplitude as a 12-bit value. This value must be 

divided by 4 to get the amplitude (i.e., 2 bits for fractional part). 

The 4 MSBs of byte 3 contain the segment number. 

 

 

Table 29: Standard CAN bus detection message 

Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0 
Segment 

(n+1) 

Amplitude 

(n+1) 

Distance 

(n+1) 

Segment 

(n) 

Amplitude 

(n) 

Distance 

(n) 

 

The detection message with flag information containing only one (1) detection and the format is as 

below: 

Data bytes 0 and 1 contain the distance in units defined by “distance units” holding data. 

Data bytes 2 and 3 contain the amplitude. This value must be divided by 64 to get the amplitude 

(i.e., 6 bits for fractional part).  

The byte 4 contains the flag information as described in Table 28. 
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Table 30: Flag information of measurement 

Bit 0 Detection is valid (will always be set) 

Bit 1 Detection was the result of object demerging 

Bit 2 Reserved 

Bit 3 Detection is saturated 

Bit 4 Reserved 

Bit 5 Reserved 

Bit 6 Detection is within the crosstalk zone 

Bit 7 Reserved 
 

The byte 5 contains the segment number. 

Data bytes 6 and 7 are reserved. 

Table 31: CAN bus detection message definition with flag information 

Byte 7 Byte 6 Byte 5 Byte 4 Byte 3 Byte 2 Byte 1 Byte 0 

- - Segment 

(n) 

Flag 

(n) 

Amplitude 

(n) 

Distance 

(n) 

1874 (0x752) (Tx base ID + 2) 

This is an 8-byte message for multiple message mode using the same format as 0x750 message 

(see above). Detections are sent on a message ID range from 1874 to [1874 + (number of 

detections / 2) + (number of detection MODULO 2)] in standard detection message and send on a 

message ID range from 1874 to [1874 + number of detections] in detection message with flag 

information. The range of message ID can be limited by the maximum number of detections to 

output to CAN port. 

Example: Sensor with 1874 base ID: 19 detections are sent. 

• From 1874 to 1884 message ID in standard detection message. 

• From 1874 to 1882 message ID in standard detection message on a sensor setup of 16 
maximum number of detections. 

• From 1874 to 1893 message ID in detection message with flag information. 

• From 1874 to 1890 message ID in detection message with flag information on a sensor setup 
of 16 maximum number of detections. 

6.6. SDK 

The Leddar™ SDK (software development kit) is a set of interfaces to allow programmers to 

integrate the IS16 industrial LeddarTM sensor in their products.  

Windows and Linux sample code is provided to get started quickly on the RS-485 link Modbus 

protocol. 
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Development through the USB link is possible with interfaces provided for C and .NET which should 

allow easy integration with most Windows environments. 

The C interface allows low level integration in C, C++, or any other languages that easily interface 

with C functions. 

The .NET interface allows easy usage in .NET languages like C# and Visual Basic but also in 

environments that support .NET integration like MATLAB™ or LabVIEW™. 

To help developers get started quickly, sample code consisting of example applications in Visual 

Studio and integration examples in MATLAB™ and LabVIEW™ are provided. 

NOTE: Complete SDK documentation is available from the Start menu (the SDK must be selected 

during the installation of Leddar™ Configurator software). 
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 Acquisition Settings 

7.1. Measurement Rate 

The measurement rate determines the speed of detection. 

The choices are: 1.5625 Hz, 3.125 Hz, 6.25 Hz, 12.5 Hz, 25 Hz, and 50 Hz. 

Lower measurement rates provide the highest range, accuracy, and precision. It is recommended 

to use the lowest measurement rate required. 

NOTE: Changing the rate will modify the duration of the output activation/deactivation delay and 

the automatic LED intensity mode change delay settings. 

 

7.2. Threshold Offset 

The threshold offset is a value that modifies the detection amplitude threshold. 

A default detection threshold table was determined to provide robust detection and minimize false 

detections caused by noise in the input signal. 

Figure 26 presents the threshold table for a LED intensity of 16. This table is effective when the 

threshold offset value is 0. 

 

Figure 26: Detection thresholds 
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The multiple lines on each graph present the thresholds for a number of accumulations of 1 (top 

curve), 2, 4, 8, 16, 32, 64, 128, and 256 (bottom curve). Accumulations of 512 and 1024 are also 

available, although not shown (provide the lowest thresholds). 

The threshold offset parameter has the effect of offsetting each value in the threshold table by the 

selected value. This provides a means of reducing the sensitivity (positive value) or increasing the 

sensitivity (negative value) of the sensor. Increasing the value of the threshold offset allows ignoring 

(will not result in a measurement) signals with amplitude higher than the default threshold. 

Decreasing the value of the threshold offset allows measurements of amplitude signals lower than 

the default threshold. Note that the default setting (0) is selected to ensure a very low occurrence 

of false measurements. False measurements are likely to occur when reducing the threshold offset 

(negative values). These false measurements are very random in occurrence while true 

measurements are repeatable. For this reason, it may be useful in some applications to use a 

higher sensitivity and filter out the false measurements at the application level. For example, this 

can be useful in applications that require long detection ranges or detection of small or low 

reflectivity targets. 

7.3. Useful Range 

The sensor range capacity depends on the LED intensity and the acquisition parameters; mostly 

the measurement rate. The slower the rate, the more light the sensor can collect from objects, 

increasing the sensor range. 

The useful range parameter does not impact the range capacity, it simply specifies in which range 

the sensor will operate and report objects. 

This parameter can serve the following purposes: 

• Minimize data throughput over the RS-485 or CAN link by avoiding detection of objects beyond 
the application range. 

• Minimize application level data processing by avoiding detections beyond the application 
range. 

• Improve data viewing in LeddarTM Configurator by avoiding detections beyond the application 
range and by limiting the beam in the main window to display the useful range only. 

7.4. LED Intensity 

There are a total of 8 supported LED power levels. Their approximate relative power is as follows: 

10%, 20%, 35%, 50%, 65%, 80%, 90% and 100%.  

There are three power control modes:  

• manual 

• automatic mode 1  

• automatic mode 2 

With the manual mode, the light power source of the sensor is set to a fixed value. This mode can 

be used in a controlled environment of sensor FOV. 
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For automatic mode, the change delay defines the number of measurements required before 

allowing the sensor to increase or decrease by one the light source power level. For example, with 

the same change delay, the maximum rate of change (per second) of the light source power will 

be twice higher at 12.5 Hz than at 6.25 Hz. The change delay can be set by the number of detection 

frame and the number of segments in saturation mode can be tolerated (automatic mode 1 only). 

 

The change delay defines the number of measurements required before allowing the sensor to 

increase or decrease by one the LED power level. For example, with the same change delay, the 

maximum rate of change (per second) of the LED power will be two times higher at 12.5 Hz than 

at 6.25 Hz. 

NOTE: Since the change delay parameter is a number of measurements, the delay will vary if 

the measurement rate is changed. 

Keeping the sensor in automatic LED power mode (default setting) ensures it adapts to varying 

environments. Close range objects may reflect so much light they can saturate the sensor, reducing 

the quality of the measurements. This mode will adapt the light output within the change delay 

setting to reach the optimal amplitude. On the other hand, low amplitudes provide lower accuracy 

and precision. The automatic LED power mode will select a LED intensity that provides the highest 

intensity that avoids the saturation condition. 

This automatic light source power mode will select a light source intensity that provides the highest 

intensity that avoids the saturation condition. The automatic mode 2, will adapt the light output 

within the change delay (frame parameter only) to reach at least one or more segments in saturation 

condition to provide the highest detection range. This mode is useful to keep a highest detection 

range into non-saturated segments when a strongly reflective object is detected.  

 

NOTE:  When a strongly reflective or near object is present in the field of view while monitoring 

farther distances, the automatic adjustment will reduce the effective range of the sensor (reduce 

LED intensity) and may prevent detection of long-range or low reflectivity objects. For these 

applications, manual mode with LED power set to 100% may be a better setting. 

7.5. Object Demerging 

One advantage of LeddarTM sensors is the capacity to detect multiple objects in the same segment. 

This is possible when an object in a segment does not occupy the full cross section of that segment. 

Objects behind will still be illuminated and may be detected if enough light is reflected back and 

captured by the sensor. The sensor performs full waveform analysis of the input signal and will 

detect all objects. 

However, if 2 objects are separated by less than 5 m to 6 m, the straightforward analysis will not 

discriminate the 2 signals since the pulses analyzed are “merged”. 

Object demerging is an advanced signal processing method developed by LeddarTech that 

extracts measurements from merged pulses characteristic of close objects. 

Note that the precision and resolution of demerged objects are lower than typical single object 

detections. Object demerging is available for measurement rates 1.5625 Hz, 3.125 Hz, and 6.25 Hz 

and the number of merged pulses that can be processed each frame is limited. A status field is 
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available in the device states window (LeddarTM Configurator) indicating if the sensor processes all 

merged pulses. 

7.6. Cross Talk Removal 

Crosstalk is a phenomenon inherent to all multiple segments time-of-flight sensors. It causes a 

degradation of the distance measurement accuracy of an object when one or more objects with 

significantly higher reflectivity is detected in other segments at a similar distance.  

This option enables an algorithm to compensate the degradation due to crosstalk. 
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 LeddarTM Configurator 

Leddar™ Configurator provides configuration parameters and operation functionalities for Leddar 

products. 

8.1. Introduction 

The Configurator interface can be resized manually or set to full-screen view. 

All dialog boxes that do not include a selection of action buttons at the bottom, such as Connect, 

OK, Cancel, etc. are dockable at the top, the bottom, or on the right side of the main window. 

 

Figure 27: Raw Detections dialog box docked on the side of the main window 

When a dialog box or a window is already open a check mark appears next to the command on the 

menu. 
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8.2. Connection Window 

The following is a description of the information shown in the Connection dialog box. 

 

Figure 28: Connection dialog box 

 

Select a connection Type 

The connection type you are using. 

Device list 

The device list displays the device currently detected. 

Name 

The device name can be modified (see section 8.3.1 Device Name). 

Serial Number  

The serial number of the device as assigned by LeddarTech 

Type 

The product name 

Leddar™ Configurator Main Window 

After connecting to the device, the main window opens. 
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Figure 29: Leddar™ Configurator main window 

The measurements are plotted in a symbolic graph containing the 16 segments (white lines) 

originating from the sensor. Detections are drawn as arcs in their corresponding segments. Only 

valid measurements are displayed. A more detailed description of the measurements can be 

obtained in the Raw Detections dialog box (see section 8.19 Raw Detections). 

The X and Y numbers displayed at the bottom are the mouse cursor position coordinates. 

8.2.1. Toolbar Display Controls 

The toolbar includes several buttons for adjusting the view of the main window display. 

Fit to window 

Click the fit-to-window button  to adjust the sensor view to the main window. 

Force equal horizontal and vertical scales 

When the equal scaling button  is selected (button highlighted), the original ratio of the display 

is kept or restored. The horizontal and vertical scales will be set to the same values and the beam 

will be displayed in accordance with the beam properties (for example, the display will show a 45° 

beam for a 45° sensor). 

Click the button again to change the vertical and horizontal scales independently. 

NOTE: When in equal scaling mode, you cannot zoom the display horizontally or vertically, that 

is, holding the <Control> or <Shift> key down while zooming in or out will have no effect. 

The scales cannot then be modified by entering values in the fields shown in Figure 29 

above. 

Vertical scale 

setting areas 

Horizontal scale 

setting areas 
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Zoom in 

Click the zoom in button  to zoom in vertically and horizontally around the center of the display. 

Zoom out 

Click the zoom out button  to zoom out vertically and horizontally around the center of the display. 

8.2.2. Scale 

The window opens with the default scale setting. The horizontal and vertical scales can be changed 

manually by entering new values in the fields accessible by clicking the areas shown in Figure 29 

above. 

To apply the changes, click anywhere in the main window. 

8.2.3. Panning and Zooming 

The display in the main window can be panned and zoomed in different ways. Panning and zooming 

is done relative to the mouse cursor position. 

You can move up, down, and sideways by clicking and dragging the display. 

To zoom the display in and out, use the mouse wheel alone. This has the same effect as clicking 

the zoom in  or zoom out  button respectively (see sections 0 and 0). 

To zoom the display horizontally, hold the <Control> key of the computer keyboard down while 

using the mouse wheel. 

NOTE: The equal scaling button  must not be selected (not highlighted). 
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Figure 30: Zooming in (left) and out (right) horizontally 

To zoom the display vertically, hold the <Shift> key down while using the mouse wheel. 

NOTE: The equal scaling button  must not be selected (not highlighted). 

   

Figure 31: Zooming in (left) and out (right) vertically 

The measurements of a detection point appear as a pop-up when you point to it with the mouse 

cursor for a more accurate assessment of the detection. Detection points are shown in the form of 

green lines (arcs) in the main window for visibility reasons. 
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Figure 32: Detection point coordinates 

8.2.4. Changing the Sensor Origin 

The sensor origin can be modified by clicking the sensor origin at the bottom of the segments. 

To do so, use the mouse cursor to point to the bottom of the segments (a red dot appears); click 

and drag it in the desired position. 

 

Figure 33: Dot indicator to modify the sensor origin 
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If you click and drag the sensor origin, the sensor position is displayed in the status bar as shown 

in Figure 34 below. 

 

Figure 34: Sensor position display 

To apply the changes, click the apply button . 

The sensor origin is saved in the sensor and can also be modified by editing the parameters in the 

sensor position settings window (see section 8.3.3 Sensor Position). 

8.2.5. Changing the Sensor Orientation 

The sensor origin may be rotated to match the physical position of the sensor. If you do so, the 

main window display can better match the physical installation of the sensor. For example, if the 

sensor is installed above the ground, the sensor origin can be set to reflect its position. 

Use the mouse cursor to point to the top of the segments (the top turns red); click and drag it in the 

desired position. 
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Figure 35: Red bar to rotate the sensor position 

To apply the changes, click the apply button . 

The sensor orientation is saved in the sensor and can also be modified by editing the parameters 

in the sensor position settings window (see section  8.3.3 Sensor Position). 

8.3. Settings 

The sensor stores a number of settings. Once saved in the sensor, these parameters are effective 

at each power up. The Leddar™ Configurator software loads these parameters upon each 

connection. 

8.3.1. Device Name 

When you connect to a sensor for the first time, it has a default name. You can change that name 

at any time. 

To change the device name: 

1. Connect to a device. 

2. On the Device menu, point to Configuration and click Device Name. 
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Figure 36: Device menu and The Configuration menu items 

3. In the Device Name dialog box, in the Name field, enter the new name of the device and click 
OK. 

 

Figure 37: Device Name dialog box 

To apply the change, click the apply button  in the Leddar™ Configurator main window. 

8.3.2. Acquisition Settings 

The acquisition settings allow you to define parameters to use for detection and distance 

measurement. 

To open the Acquisition Settings dialog box, select Device > Configuration > Acquisition. 

Refer to section 7 Acquisition Settings for more details on all the parameters. 
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Figure 38: Acquisition Settings dialog box 

To apply the changes, click the apply button  in the main window. 

8.3.3. Sensor Position 

The sensor position allows you to define the sensor position with respect to the reference of the 

system it is used in. See sections 8.2.4 and 8.2.5 for more information. 

To open the Sensor Position dialog box, on the Device menu, point to Configuration and click 

Position. 

   

Figure 39: Device menu and Sensor Position dialog box 

The numbers are modified either by using the arrows or by entering the value manually. 

The Reset to default button replaces the segments to their original manufacturing positions. 
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8.3.4. General 

The sensor General communication settings are configurable. 

To open the General Settings dialog box, on the Device menu, point to Configuration, point to 

Communication, and click General. 

 

Figure 40: Device menu, and the Configuration and Communication menu items 

In the General Setting dialog box, in the Distance Units list, select the units with which you want 

to work. 

 

Figure 41: General Settings dialog box 

The number of channels used is set to 16 by default but you can remove some of them to suit your 

application through the LeddarHost dialog box. Next to Channel Select, click Modify and clear 

the desired check boxes. 

In Modbus and CAN communications, you can either enable or disable one or more channels. 
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Figure 42: LeddarHost dialog box 

8.3.5. Serial Ports 

The sensor serial port settings are configurable. 

To open the Serial Ports Settings dialog box, on the Device menu, point to Configuration, point 

to Communication, and click Serial Ports. 

 

Figure 43: Device menu, and the Configuration and Communication menu items 

In the Serial Port Setting dialog box, the numbers are modified by using the arrows or by entering 

the value manually. 
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Figure 44: Serial Ports Settings dialog box 

NOTE: The Detections parameter can be limited to 40 if used with a 0x6A Modbus function. 

The following table describes the serial port settings. 

Table 32: Serial port settings description 

Parameter Value 

Port Number Select 1 for the RS-485 port on the terminal block 

Baud Rate 

9 600 bps 

19,200 bps 

38,400 bps 

57,600 bps 

115,200 bps 

230,400 bps1 

460,800 bps1 

921,600 bps1 

Parity None, odd, even 

Stop Bits 1, 2 

Address 1 to 247 

Detections2 0 to 48 

 
1 To avoid errors, it is recommended not to select these rates. Availability according to selected serial port. 
2 This parameter can be limited to 40 if used with a 0x6A Modbus function. 
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8.3.6. CAN Ports 

The sensor CAN port settings are configurable. 

To open the CAN Port Settings dialog box, on the Device menu, point to Configuration, point to 

Communication, and click CAN Port. 

 

Figure 45: Device menu, and the Configuration and Communication menu items 

 

In the CAN Port Setting dialog box, the numbers are modified by using the arrows or by entering 

the value manually. 

 

Figure 46: CAN Port Settings dialog box 

The following table describes the CAN port settings. 
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Table 33: CAN port setting description 

Parameter Value 

Port Number Select 1 for CAN communication 

Baud Rate 10, 20, 50, 100, 125, 250, 500, 1000 kbps 

Base Tx Id 

The CAN arbitration ID used for data messages coming from the evaluation 

kit containing the detections. The arbitration ID of the messages containing 

the number of detections will be this value plus one (see the protocol 

documentation). 

Base Rx Id 
The CAN arbitration ID used for data messages sent to the evaluation kit (see 

the protocol documentation). 

Frame Format Standard, Extended 

Inter-

Message 

Delay 

0 to 65535 milliseconds 

Inter-Cycle 

Delay 

0 to 65535 milliseconds 

Detection 

Flag Info 

The information on the detection flag is displayed in the main window. 

Detections 1 to 96 

Detection 

Transfer 

Single or multiple messages 

 

8.4. Saving and Loading a Configuration 

The software configuration for a device can be saved to a file. This enables you to back up settings 

and restore them in case of system failure or in case you want to revert to earlier settings. You can 

also get the configuration that was stored with a record file. 

To save a configuration: 

On the File menu, click Save Configuration. 
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Figure 47: File menu 

To load a configuration: 

On the File menu, click Load Configuration. 

8.5. Configuring Detection Records 

Detection records provide a playback of detections recorded by a device. This visual information 

can be useful for verification, troubleshooting, or training purposes. Detection records allow for a 

full data playback stored in a *.ltl file that can later be reloaded and replayed. 

To configure the detection record: 

1. In Leddar™ Configurator, on the Settings menu, click Preferences. 

 

Figure 48: Settings menu 

2. In the Preferences dialog box, click Recording and click Recorder. 
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Figure 49: Preferences dialog box 

3. Under Directory, click the Browse button to select the path where you want to save the 
detection record file. 

4. In the Maximum file size box, set the maximum file size by using the arrows or by entering 
the value manually. 

5. Under What, select the Log debug information check boxes. 

6. Under How Long, next to Maximum record time, determine the length of time for recording 
by using the arrows or by entering the value manually. 

At the end of that period, recording will stop even if the file size has not reached its maximum. 

7. Click OK to save the settings. 

A complete description of the elements found in the Preferences for recording dialog box follows 

after the next two procedures. 

To start a recording: 

On the File menu, click Start Recording. 

 

Figure 50: File menu 
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Figure 51: File menu to stop a recording 

The following is a description of the elements available in the Preferences for recording dialog box. 

Record directory 

The record directory is the folder in which all record files will be saved. These files are in a 

proprietary format, with the extension *.ltl, and can only be opened and viewed with the Leddar™ 

Configurator software. 

Maximum file size 

Record files can be quite large. Set the maximum file size as needed. The recording stops for the 

current file once it reaches the maximum file size and automatically switches the recording to 

another file. This is to keep record files of manageable sizes. 

Debug 

These check boxes are reserved for the use of LeddarTech technicians. 

Maximum record time 

The value entered as the Maximum record time determines the length of the time for recording. 

At the end of that period, recording will stop even if the file size has not reached its maximum. 

8.6. Using Detection Records 

Once you have completed a recording, you can review it and extract part of the recording. 

The Record Replay dialog box offers the same functions as a regular video player: there is a stop 

button, a play button, and frame-by-frame forward and backward buttons. 

The Position slider lets you move directly to a desired position. 

The Playback Speed slider lets you adjust the speed of the recording playback; faster is to the left. 

The Start, End, and Extract buttons allow you to select a portion of the recording and extract it for 

further reference or analysis. 
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To play a record: 

1. If you are connected to a device, disconnect from the device. 

OR 

Open another Leddar™ Configurator main window. 

NOTE: The record files can also be opened by double-clicking them. 

2. On the File menu, click Replay. 

 

Figure 52: File menu to open a recording 

3. In the Record Replay dialog box, click the browse button to select a file. 

 

Figure 53: Record Replay dialog box 

4. Click the play button to start the playback. 

 

To extract a record file segment: 

1. Set the Position slider to the position where you want the file segment to start and click the 
Start button. 

2. Set the Position slider to the position where you want the file segment to stop and click the 
End button. 

OR 

Play 

button 
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Play the record and stop it at a position of interest and then click the Start button; restart 

playing the record and stop it again at a position of interest and click the Stop button. 

3. Click the Extract button to extract and save that file segment. 

8.7. Data Logging 

The data logging function is used to output the data to a .txt file. This file can be imported in a software 

application, such as Microsoft Excel, for offline analysis. 

The duration of the record is indicated in the status bar. 

Each line of the generated text file contains the information related to a single detection. 

Table 34: Field description of the log text file 

Time (msec) Segment [0 15] Amplitude [0 512] Distance (m) Status 

12735204 7 0.9 33.61 1 

In this table, 

• Time indicates the timestamp of the detection from when the sensor was connected to the 
power supply. 
 

• Segment refers to the location of the detection (line, column). 
 

• Amplitude of the detection indicates the strength of the returned signal. 
 

• Distance indicates the distance of the detection in meters or in feet depending on the 
distance unit configured in the Preferences menu. 

 

• Status corresponds to a flag value. Refer to Section 6 Raw Measurements Mode for more 
details. 

 

To use the data logging function: 

1.  In Leddar™ Configurator, on the Settings menu, click Preferences. 

 

Figure 54: Settings menu 

2. In the Preferences dialog box, click Recording and click Data Logger. 
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Figure 55: Preferences dialog box for logging data 

3. Under Directory, click the browse button to select the path where you want to save the log 
and click OK. 

4. On the File menu, click Start Data Logging. 

 

Figure 56: File menu 

5. To stop recording, on the File menu, click Stop Data Logging. 

 

Figure 57: File menu to stop data recording 

A .txt file is saved in the selected directory. 
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8.8. Device State 

Information about a device is accessible when connecting to a device in the Connection window 

or by clicking the State command on the View menu. 

 

Figure 58: View menu 

The Device State window opens. 

 

Figure 59: Device State window 

Temperature 

This section indicates the temperature of the device. 

Timers & Load 

This feature gives information in days, hours, minutes, and seconds about two types of activities of 

a device. The first line indicates the time elapsed since the last device reset, the second since the 

last power cut or outage. 

 The CPU Load indicates how much of the sensor processor capacity is in use. When the load 

reaches near 100%, the processor may no longer be able to process all the data. The effective 

frame rate may be impacted. 

The Measurement Rate indicates the rate at which the sensor measures the speed and dimension 

of static or moving surfaces. 
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Device Information 

The Serial Number is the number of the device as assigned by LeddarTech. 

The Version includes the following: 

• FPGA: The firmware version of the device. 

• Software: The software version of the device. 

• CRC: Indicates the firmware version to ensure that it is authentic. 
 

The Part Numbers provide the hardware and software part numbers of a device as assigned by 

LeddarTech. 

 The LED Intensity is the current LED power in use by the sensor. It automatically adapts to too 

strong/too weak detections when properly activated in the acquisition settings window.  

The Demerging indicates the current object demerging status when activated in the acquisition 

settings. It may be: 

• Partial: when the demerge sensor didn’t process all pulses characteristic of merged objects. 
Completed: when the sensor processed all pulses characteristic of merged objects. 
 

8.9. Preferences 

 
Preferences are used to change various settings related to the display of Leddar™ Configurator. 

The Preferences dialog box is opened by clicking the Preferences command on the Settings 

menu. 

   

Figure 60: Settings Menu and Preferences Dialog Box 

Windows 

The two options allow the user to select how the content of the main window will be displayed in 

Leddar™ Configurator. Choices are: 
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• The Restore window position and size on startup feature starts Leaddar™ Configurator at the 
same place on the computer desktop and at the same size it was when it was closed. 

• The Restore window layout on connection the feature connects to the Evaluation Kit at the 
same size it was and with all docked dialog boxes or windows that were displayed when it was 
closed. 

Units 

The unit that is applied to distances displayed in Leddar™ Configurator. 

The Temperature is the unit used when displaying temperatures. 

Recording 

The Recorder parameter lets you choose how data files are recorded. 

The Data Logger parameter lets you select a directory to store logs. 

Display 

The Detection Arc Thickness parameter allows a user to modify the pixel width of the displayed 

green detection arcs in the main window. 

8.10. Raw Detections 

The Raw Detections dialog box allows you to view detection values in many ways. It provides 

filters to isolate segments and detection parameters. 

To open the Raw Detections dialog box, on the View menu, click Raw Detections. 
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Figure 61: View menu and Raw Detections dialog box 

Figure 62 presents an example of raw detections. When there is no detection in some segments, 

only the segments where detection occurred appear in the list. 

 

Figure 62: Example of detection filters 

The following is a description of the parameters available in the Raw Detections dialog box. 
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Min and Max Amplitude 

The value entered in the Min Amplitude box shows only detections of amplitude higher or equal 

to that value. For example, if the minimum amplitude is set to 5, only the detections of amplitude 5 

and more will be displayed. 

The value entered in the Max Amplitude box will show only detections of amplitude lower or equal 

to that value. For example, if the maximum amplitude is set to 8, only the detections of amplitude 

8 and lower will be displayed. 

Setting a value in both fields will result in a range of amplitude to display. 

Min and Max Distance 

The value entered in the Min Distance box will show only detections at a distance greater or equal 

to that value. For example, if the minimum distance is set to 10, only the detections at a distance 

of 10 and more will be displayed. 

The value entered in the Max Amplitude box will show only detections at a distance smaller or 

equal to that value. For example, if the minimum distance is set to 20, only the detections at a 

distance of 20 and less will be displayed. 

Setting a value in both fields will result in a range of distance to display. 

Boxes 1 to 16 

Check boxes 1 to 16 allow you to select which segments to display. 

Freeze 

When selected, the Freeze parameter freezes the values displayed in the Raw Detections dialog box. 

To return to the live display, clear the check box. 

Seg 

The Seg column lists the segment for which there is a detection according to the filters used. The 

segment numbers are read from left to right starting at 1. 

Distance and Amplitude 

The Distance column displays the distance of the detection and the Amplitude column displays 

its amplitude. 

Flag 

The Flag column displays a number that represents a detection type. See Table 35. 
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Table 35: Flag value description 

Bit position Bit 0 Bit 1 

0 Invalid measurement Valid measurement 

1 Reserved Reserved 

2 Reserved Reserved 

3 

Normal measurement Received signal is above the saturation level. 

Measurements are valid (VALID is set) but 

have a lower accuracy and precision. 

Consider decreasing the LED intensity. 

4 Reserved Reserved 

5 Reserved Reserved 

6 Reserved Reserved 

7 Reserved Reserved 

 

The Flag field provisions for 8 bits encoded as a bit field. Three bits are currently used. The 

following table presents the implemented decimal values of the status bit field.  

Table 36: Status value description 

Status value (decimal) Status value (binary) Description 

1 00000001 Normal measurement (valid) 

9 00001001 Saturated signal (valid) 

8.11. View Serial Port Data 

When using a device through a serial port (for example, using an RS-485 to USB adapter cable), it 

is possible to establish a connection to the sensor and display the sensor measurements in 

Leddar™ Configurator. 

To view the serial port data: 

1. On the View menu, click Serial Port Viewer. 

 

Figure 63: View menu 

2. In the Serial Port Viewer dialog box. In the Port list, select the serial port of the connected 
sensor. 
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Figure 64: Serial Port Viewer dialog box 

Click the Start button to establish connection and display the measurements. 
 

 

Figure 65: Serial port measurement 
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 Specifications 

This chapter presents the IS16 LeddarTM sensor specifications. 

9.1. General  

Table 37: General specifications 

LED pulse rate 102.4 kHz 

Photodetector array size 1 x 16 

Measurement rate 1.5625, 3.125, 6.25, 12.5, 25, 50 Hz. 

USB 2.0, 12 Mbits/s 

RS-485 2-wire, half-duplex, 9600 to 115200 BPS 

Operating temperature -40°C to +50°C 

 

9.2. Mechanical  

Table 38: Mechanical specifications 

Height 136 mm 

Width 86 mm 

Depth 70 mm 

Weight 430 g 

 

9.3. Electrical  

Table 39: Electrical specifications 

DC supply voltage 12-30 V 

PNP/NPN output load current 

(max) 
100 mA 

Power consumption 5.6 W 
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9.4. Optical 

Table 40: Optical specifications 

Beam width 48° 

Beam height 8° 

Wavelength 940 nm (infrared) 

LED risk group IEC 62471-2006 exempt lamp classification 

 

 

 

Figure 64: Beam pattern 
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Figure 66: Detection efficiency (beam width by segments) 

 

 

 

Figure 67: Detection efficiency (beam height) 
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9.5. Performance 

Table 41: Sensor performances 

 

Measurement accuracy ±5 cm 

Measurement precision 6 mm (amplitude > 15) 

Resolution 1 cm 

Range (maximum LED intensity) See Figure 70 

 

 

Figure 68: Accuracy vs. amplitude 

 

 

Figure 69: Precision vs. amplitude 
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Figure 70: Amplitude vs. distance 
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9.6. Dimensions  

 This section presents the IS16 LeddarTM sensor dimensions.  

 

Figure 71: Casing dimensions 

NOTE: The connector illustrated above is a male connector even though threads are not represented. 
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9.7. Regulatory Compliance 

This device complies with: 

Table 42: Compliance to standards 

Sinusoidal vibration IEC 60068-2-6 

Mechanical shocks IEC 60068-2-27 

Thermal shock IEC 60068-2-14 

Protection against ingress of water 
IEC 60529 

Code IPX7 

Protection against ingress of dust 
IEC 60529 

Code IP6X 

Protection against ingress of solid objects 
IEC 60529 

Code IP6X 
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 Technical Support 

For technical inquiries, please contact LeddarTech technical support by registering online at 

www.leddartech.com/support to easily: 

• Follow up on your requests 

• Find quick answers to questions 

• Get valuable updates 

Or by contacting us at: 

• + 1 418 653 9000 

• + 1 855 865 9900 

8:30 a.m. - 5:00 p.m. Eastern Standard Time 

To facilitate the support, please have in hand all relevant information such as part numbers, serial 

numbers, etc. 

 

E-mail 

support@leddartech.com  

 

Company address 

LeddarTech Inc. 
4535, boul. Wilfrid-Hamel, #240 
Quebec, QC G1P 2J7 
Canada 

 

www.leddartech.com 

  

http://www.leddartech.com/support
mailto:support@leddartech.com
http://www.leddartech.com/
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